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We’re halfway through 2019 and there’s no slowing down!  Power BI still has 20 
trillion updates a month, the market emphasises the importance of data visualisation and business intelligence, SumProduct begins the 
Excel Summit South conference tour of Australia, Microsoft has issued a whole load of freebies, Mac Excel is becoming more useful and 
our newsletter still attempts to reach the 100-page mark.  

My old English teacher would turn in his grave at the size of that last sentence – if he were dead!

This month, we consider depreciation using both OFFSET and DDB (not at the same time!) and continue our regular 
series on VBA, Power Pivot and keyboard shortcuts.  

Hope to see some of you at the Excel Summit South events soon.

Until next month.

Excel Summit South: Final Call

contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

www.sumproduct.com  |  www.sumproduct.com/thought

Liam Bastick, Managing Director, SumProduct

It starts the end of this month – have you got your ticket yet?  We’d love to see you there.  Our Microsoft and MVP presenters from Australia, 
Bulgaria, Slovenia, the UK and the USA (hopefully, somebody can speak English!) are all getting ready to come and talk about all things 3D Maps, 
Auditing Spreadsheets, Charts, Dashboards, Data Analysis, Data Types, Dynamic Arrays, Excel Tricks & Tips, Financial Modelling, Forecasting, Office 
365, PivotTables, Power BI, Power Pivot, Power Query, Presenting Your Data in PowerPivot, Simulations Analysis, Slicers, Spilled Formulae, Testing, 
Timelines and VBA.

Bring a laptop, an inquisitive mind and your sense of humour.  Be prepared to learn heaps over two days.  We are travelling around Australia as 
follows:

	 •	 Brisbane: Monday 29 and Tuesday 30 July
	 •	 Sydney: Thursday 1 and Friday 2 August
	 •	 Melbourne: Monday 5 and Tuesday 6 August
	 •	 Perth: Thursday 8 and Friday 9 August.

Check out the website at www.excelsummitsouth.com for all the details, prices and registration.  Early Bird pricing is nearly over.  Don’t miss out – 
and remember, the additional 10% off using the code NEWSLETTER 10.  Hopefully, we will see you there!
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Data visualisation and Business Intelligence continue to make in-roads in 
the worldwide business communities.  Announced mid-month (but still 
newsworthy), in its largest deal to date, Salesforce.com Inc. has agreed 
to buy Tableau Software Inc., in an all-stock deal valued at US$15.3 
billion.  It's clearly a major bid to build the acquirer's analytics offering.  
It is understood that by reaching through combined new markets the 
intention is to build an annual revenue of US$26 - $28 billion by fiscal 
year 2023.

Tableau’s HQ will stay in Seattle and will continue to be led by present 
Chief Executive Officer Adam Selipsky, who has been responsible for 

the transition of Tableau’s software tools to cloud-based subscriptions, 
similar to other "well-known" products out there...

Highly respected for its chart applications and analytics dashboards, 
Tableau has been broadening its product line to include data cleansing 
and Machine Learning (ML) tools, enabling it to compete in the wider 
data-warehousing market and take the battle to Power BI, amongst other 
competitors.

We watch the space with interest.  

The 2019 Microsoft Business Applications Summit may be over.  It 
covered so much more than Excel, with both Microsoft staff and Most 
Valuable Professionals (MVPs) presenting on all things Dynamics 365, 
Power BI, Excel, PowerApps, Microsoft Flow, and mixed reality. 

If you didn’t go – we didn’t – don’t worry.  Microsoft has released a whole 
load of freebie videos and PowerPoint slides that summarise much of the 
cool stuff.  Immerse yourself here: 

It’s not there yet – but it’s starting!  Too late to announce in last month’s 
newsletter, the end of May saw Excel for Mac taking its first steps into 
Power Query Land (who said this was Never Never Land?).  

Up until now, Power Query has not been supported in Excel for Mac, but 
the tide is turning.  Starting with anyone with Office Insiders Fast in Excel 

for Mac version 16.26 (19052200) or later, the journey starts now.

As of this release, end users may refresh Power Query queries on a Mac 
– albeit for CSV, JSON, Text, XLSX and XML files only.  It may only be baby 
steps – but it’s a significant start.

•	 Microsoft Excel: Whirlwind Tour 2019 (deck)

•	 Microsoft Excel: Getting Started with Dynamic Arrays in Excel (deck)

•	 Microsoft Excel: Best practices for spreadsheet modeling, data shaping, and data analysis (deck)

•	 Microsoft Excel and Visio: Unlock the power of data-driven diagramming (deck)

•	 Microsoft Excel: Collaboration in Excel (deck)

•	 Microsoft Excel: Boost your productivity with Excel on the web (deck)

•	 Design and create business workflows automatically using Microsoft Excel, Flow, and Visio (deck)

•	 Microsoft Excel: How I leveraged Excel, Microsoft Flow, Power Query, and Power BI to optimize busine... (deck)

•	 Microsoft Dynamics 365: Excel life hacks for Dynamics 365 Business Central (deck)

Salesforce Buys Tableau

Free Stuff from Microsoft Business Applications Summit 2019

Power Query in Excel for Mac
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To see how it might work for you, refresh your workbook queries as you would do normally (either using Data -> Refresh All or VBA).  The refresh will 
now work for the file types stipulated above.  You might need to update the file path so that it works.  In this instance, click Data -> Connections -> 
select the connection that failed to refresh -> Change File Path to update.

Alternatively, you could use a PC (bang goes our Apple freebies).

Insert Data from Picture is now Generally Available to iPhone users, 
including support for no less than 21 languages for both the Android 
version of the app (available since March) and the new iPhone one.  

This tabular recognition feature for Excel combines advanced Optical 
Character Recognition (OCR) technology and machine learning models 

to transform paper-based information into digital data.  Insert Data 
from Picture brings printed, tabular data directly into Excel, where you 
can perform various kinds of analysis that are time-consuming or even 
impossible with pen and paper. 

Simply open the Excel app on your phone, snap a picture of your paper-
based data table, crop and review the image, and you’re done—no 
technical skills required.  The data table is automatically embedded and 
ready for analysis in Excel.

Going from analogue to digital gives you time for more important tasks 
and is more secure.  In addition, once a printed copy is converted, digital 
records are easier to organise and search—eliminating paper waste and 
reducing physical storage space.

Here are just a few examples of how users can benefit from Insert Data 
from Picture:

	 •	 Consolidate dozens, hundreds, or even thousands of rows of paper-	
		  based data in a flash—all without a single pencil mark
	 •	 Create illustrative charts and graphs to summarise information that 	
		  was extremely difficult to communicate before
	 •	 Use Ideas in Excel to surface new trends and dependencies you 		
		  might have missed when your data only existed on paper
	 •	 Easily archive data documents for future reference and compliance 	
		  purposes.

To enable seamless data extraction from an image, Insert Data from Picture 
reuses many of the same OCR and Layout technologies previously released 
for Word (e.g. the PDF Reflow feature), Office Lens, and Seeing AI.

The image is analysed to detect the main building blocks of the document, 
like text and graphical elements (e.g. table borders).  For this, Microsoft 
enhanced their OCR engine to handle images with scattered text, which 
is often the case in tabular data and leveraged various image processing 
techniques to detect graphical elements.

Once the image is decomposed into main building blocks, Insert Data 
from Picture starts inferring the layout of the table.  The most important 
part is detecting the grid of the table, which is done by generating grid 
candidates from horizontal and vertical lines (for bordered tables) and 
empty spaces between text (for borderless tables).  After all the candidates 
are generated, the feature uses a combination of various heuristics and 
machine learning models to filter false positives and produce the final grid 
that will be reconstructed in the output.  Producing that final grid relies on 
the analysis of each cell to build out other structures like paragraphs, font 
properties, and lists.

For those who have used OCR-based features before, you know it doesn’t 
always get everything right.  Insert Data from Picture takes special care 
to highlight potential errors, so you can focus on individual entries rather 
than on the whole thing.  The good news is that this is an AI-powered 
feature designed for continues improvement, meaning that data accuracy 
will increase over time.  To achieve this, Microsoft leveraged the collection 
of machine learning models where each model detects a specific case of 
misrepresented content (e.g. missed or added characters).  

Insert Data from Picture Generally Available on the iPhone Excel Application
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You can download Excel for your phone and start using these apps today:

	 •	 Excel app for iPhone
	 •	 Excel app for Android

Given this month’s A to Z of Excel Functions function (DDB), we thought it might be good to hold an appreciation of depreciation.  There’s another 
good – and more common – function that can help with depreciation: OFFSET.

Just to recap, the OFFSET function employs the following syntax:

OFFSET(reference,rows,columns,[height],[width])

The arguments in square brackets (height and width) can be omitted from the formula – but they will prove to be useful here.  

OFFSET(reference,rows,columns) will select a reference rows rows down (-rows would be rows rows up) and columns rows to the right (-columns 
would be columns rows to the left) of the reference.  For example, consider the following grid:

OFFSET(A1,2,3) would take us two rows down and three columns across to cell D3.  Therefore, OFFSET(A1,2,3) = 16, viz.

OFFSET(D4,-1,-2) would take us one row up and two rows to the left to cell B3.  Therefore, OFFSET(D4,-1,-2) = 14, viz.

For this second discussion, let’s extend the formula to OFFSET(D4,-1,-2,-2,3).  It would again take us to cell B3 but then we would select a range based 
on the height and width parameters.  The height would be two rows going up the sheet, with row 3 as the base (i.e. rows 2 and 3), and the width 
would be three columns going from left to right, with column B as the base (i.e. columns B, C and D).  

Hence, OFFSET(D4,-1,-2,-2,3) would select the range B2:D3, viz.

Ideas for Modelling Depreciation
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Note that OFFSET(D4,-1,-2,-2,3) = #VALUE! since Excel cannot display a matrix in one cell (unless you have Dynamic Arrays!), but it does recognise it.  
However, if after typing in OFFSET(D4,-1,-2,-2,3) we press CTRL + SHIFT + ENTER, we turn the formula into an array formula: {OFFSET(D4,-1,-2,-2,3)} 
(do not type the braces in, they will appear automatically as part of the Excel syntax).  This gives a value of 8, which is the value in the top left hand 
corner of the matrix, but Excel is storing more than just that.  This can be seen as follows:

	 •	 SUM(OFFSET(D4,-1,-2,-2,3)) = 72 (i.e. SUM(B2:D3))

	 •	 AVERAGE(OFFSET(D4,-1,-2,-2,3)) = 12 (i.e. AVERAGE(B2:D3)).

We’ll use these ideas to build up the depreciation of capital expenditure.

Example

Let’s imagine we’ve been charged with creating a depreciation schedule in an Excel spreadsheet with the following assumptions:

All cells in yellow are assumptions that may be changed.  

We wish to build a depreciation grid to calculate my total amortised cost as follows:

The first challenge is to link the assumptions in cells J21:O21 to the grey cells H30:H35, converting row assumptions into column data.  Converting 
from rows to columns (or vice versa) is known as transposing.  There are several ways you can do it, but only one way I truly recommend.

For the purposes of simplification, I’m going to assume that we are looking to transpose data from going across a row to going down a column (the 
concepts are similar if columns are transposed into rows).

This method is very simple.  First, create a formula that links to the data to be transposed, say, in the row beneath:

Method 1: Cut and Paste a Formula
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Second, once the formulae have all been created, cut and paste each formula individually into its appropriate position on the spreadsheet:

This is a very simple method, but certainly would be an ill-advised approach if you need to transpose 1,000 data points, for example.  

However, simplicity is often a highly-underrated attribute in modelling.  If you only have a few data items and you require the original inputs to remain 
(in our example, row 12, above), this method can often be deemed “simplest bestest”.

In this instance, simply highlight the data and copy the range in the usual 
way (e.g. CTRL + C).  Next, simply select the first cell (i.e. the top left hand 
corner) of the intended range and Paste Special, Transpose (ALT + E + S 
+ E + ENTER).  As can be plainly seen from the illustration (above), the 
formatting as well as the content will be transposed.  

This is an ideal approach for copying and transposing data from one 
source to another where links are not required.  Aside from the inherited 
formatting, the main disadvantage here though is that depending upon 

the nature of the source data and how it is copied, updates in the original 
data will not flow through to the destination range.

If the data needs to be linked to the source, then this approach is probably 
inappropriate.  However, if inherited formatting is all that is putting you 
off, make the appropriate adjustments to the ‘Paste Special’ dialog box 
before pressing ‘OK’ / ENTER, e.g. set the dialog box as follows to copy 
only the formulae before transposing:

Another very simple approach is to copy and paste special as follows:

Method 2: Copy and Paste Special, Transpose

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

On first glance, this looks like the ‘best’ method.  Once you discover there is a TRANSPOSE function, you think life is simple and your problems (well, 
your modelling problems anyway!) are over.  Unfortunately, this function is not without its limitations.

Consider the following example:

Used with the ROWS function (which simply counts the number of rows in a specified range), transpositions may be performed quickly and effectively 
using OFFSET:

Here, the intention is to transpose the values in cells G12:K12 into the range F16:F20.  To do this, simply highlight cells F16:F20 and then type in the 
following formula:

=TRANSPOSE(G12:K12)

but rather than press ENTER, press CTRL + SHIFT + ENTER to enter the formula as an array formula.

This method is very simple, as long as you ensure that the destination range contains precisely the same number of cells in the column as there are 
cells in the source row.  If you change the source data, the outputs will update accordingly too.

So, what’s the problem?

Array formulae can consume memory exponentially, which in turn can soon prevent Excel from calculating correctly, especially if you are working on 
a Windows 32-bit operating system, which is the platform most businesses employ.  

Further, if you wanted to insert additional rows between rows 16 and 20 (e.g. to extend the range), you will find that this is not possible:

Only Chuck Norris can change part of an array, and unfortunately, he’s 
not available.

Interestingly, if you insert columns between G and K in the illustration 
above, this is possible, but the array formulae will not act like other Excel 
calculations: cell references in the TRANSPOSE formulae will not update 
(so the references will always link to what is in cells G12:K12 in our 

example).  However, if you insert columns before column G, the formula 
will update.  This can be confusing.

Therefore, TRANSPOSE is useful where you wish to protect the 
destination range’s structure, but it can be seen as inflexible and 
inefficient, particularly with larger Excel files, slowing calculation times 
down unnecessarily.

Method 3: Using the TRANSPOSE Function

Method 4: OFFSET Approach
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In this example, the following formula has been typed into cell F16:

=OFFSET($F$12,,ROWS($E$16:$E16))

As the formula is copied down, the number increases in the columns argument of OFFSET, as the number of rows increases.  This is a neat trick for 
transposing without using array formulae and can be seen as a good “general” solution, being quite flexible.  The disadvantages here are twofold:

	 •	 Often modellers make mistakes in the absolute and semi-absolute references required to make this formula calculate correctly.  This is easily 	
		  overcome with practice; and

	 •	 The formula can look unnecessarily complex to the inexperienced or uninitiated.  There are many end users (and modellers for that matter) 	
		  unfamiliar with the OFFSET function in particular. It may be worthwhile to educate them accordingly.

The formula in cell H30 (highlighted) is

=OFFSET(BC_Capex,,$E30)

BC_Capex is cell I21.  The prefix “BC” in this range name stands for “Base Cell” and is used to acknowledge the fact that OFFSET is non-auditable, as 
explained last time.  This cell is styled speckled blue to emphasise that this cell must deliberately remain blank and not be deleted.  I use this “Empty 
Cell” style regularly in modelling.

The reference $E30 points to the label “Year 1” which is actually the number 1 formatted to look like text.  This dispenses with the need to use the 
ROWS function explained earlier.

Now that I have successfully transposed the assumptions, I can calculate the depreciation grid:

Assuming depreciation is to be calculated on a straight-line basis (i.e. the capital expenditure is apportioned equally across all periods it will provide 
economic benefit), the depreciation may be calculated across the grid using the formula in cell J30:

=IF(J$28>=$E30,MIN($H30-SUM($I30:I30),$H30*Depn_Rate),)

The IF statement checks that depreciation does not commence before the capital expenditure has occurred.  The MIN function takes a proportion of 
the capital expenditure but ensures that the cumulative total (“accumulated depreciation”) does not exceed the amount spent.

It is a simple method, recognised by many financial analysts and accountants.  The main problem with this method concerns how many calculations 
are required in the grid.  For example, if you built a 20-year monthly model, you would need 240 rows by 240 columns in the grid – a total of 57,600 
calculations!

This is where OFFSET can come to the rescue… 

It is this last method I have employed in our depreciation example:

Returning to the Example
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In this example, row 44 contains the formula =MIN(J42,Economic_Life) which restricts the period counter to not exceed the Economic_Life (here, 
four years).  With row 48 calculating each period’s representative depreciation, the total depreciation charge in row 50 becomes trivial.  For example, 
the formula in cell J50 is:

=SUM(OFFSET(J$48,,,,-J44))

This formula simply refers to the corresponding periodic charge in row 48 and then sums a range of cells of width the negative value given in row 44.  
This means that:

	 •	 In Period 1, depreciation is simply given by cell J48

	 •	 In Period 2, the depreciation is the sum of the first two charges in row 48 (namely, cells J48:K48)

	 •	 In Period 3, the depreciation is the sum of the first three charges in row 48 (namely, cells J48:L48)

	 •	 In Period 4, the depreciation is the sum of the first four charges in row 48 (namely, cells J48:M48)

	 •	 In Period 5, the depreciation is the sum of the last four charges in row 48 (namely, cells K48:N48).  Note that the first period is now excluded 	
		  (the width is -4) as the first period’s capital expenditure is now fully depreciated.

A simple comparison of the two approaches to depreciation will 
determine that the two methods give the same result.  The OFFSET 
approach may not be as transparent upon first glance, but it does reduce 
the number of formulae required.  

When we model depreciation in reality, we usually model the first asset 
class both ways so that end users may see they give the same result.  
After that, we’ll adopt the OFFSET approach exclusively as end users now 
“trust” this less familiar approach.

We recommend if you are not familiar with OFFSET you should do the 
same.  Play with the function for a while until you trust it and realise how 
useful it can be in your spreadsheets going forward.

You can find an example file to play with on our website here.

We thought we’d run an elementary series going through the rudiments 
of Visual Basic for Applications (VBA) as a springboard for newer users.  
This month, we look at declaring constants.

It is highly recommended any values that are passed into formulae, 
subroutines and / or functions are variables.  However, what if the value 
of that variable does not change?  There is a way to make it immutable by 
declaring it as a constant.  This means that it cannot be changed during 

execution.  By declaring constants, they can easy to access without 
hardcoding the information more than once and make code much more 
readable and facilitate error checking.

Constants are declared in a similar way to Dim except using the keyword 
Const – except a constant should always be assigned a value when it is 
declared.

If somewhere in the code, it tries to reassign the value, the VBA Compiler spits an error message before execution.

Visual Basics
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The compiler determines what the data type is from the type of 
expression of the constant.  However, it is always good form to explicitly 
state a data type.  This is particularly important if you plan on doing 
arithmetic expressions in your code that results in what is known as a 

Long value and having an Integer constant will cause overflow errors.  
Using the As statement in a similar way to the Dim statement the data 
type of the constant may be cast.

Multiple constants can be declared on a single line as well:

Now knowing how constants are declared, like variables, the scope of the constants is also put under consideration.  This is declared the same way as 
variables – the subject of our past two articles

More next month.

We continue our series on the Excel COM add-in, Power Pivot.  This month, 
we consider relationships (in Power Pivot) and how we may create them.

A relationship is a connection between two tables of data, based on 
one or more columns in each table.  Why do we need relationships?  As 
discussed previously, Power Pivot allows you to take multiple sources 
of data and combine the data tables together into one interrelated 
database known as a relational database.  Once we have imported our 

tables of data into Power Pivot, you may need to create a relationship 
between these tables of data.  This will enable you to filter data in one 
table by columns of data from related tables, which will enable a broader 
analysis of the data.  However, it should be noted for tables to connect 
they must contain columns with matching values.

Let’s run through how to create relationships with two examples.  

Power Pivot Principles

The Diagram View provides a visual diagram layout of the data tables which enables us to easily identify relationships between our data.  To see this, 
select the ‘Diagram View’ on the ‘Home’ tab of the Power Pivot window.  This will bring up a list of all the tables that are incorporated in the model:

Here, we can see there is an obvious match: ‘Sales Territory Key’ is shown in both the ‘FactInternetSales’ table and the ‘DimSalesTerritory’ table so 
let’s join these columns together.

Diagram View
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Click on the ‘Sales Territory Key’ in the ‘FactInternetSales’ table and 
drag it down to the ‘Sales Territory Key’ in the ‘DimSalesTerritory’ table.  
That was easy (in other software, you have to specify both the direction 
and the type of linkage, not so here).  This will now create a connection 

between these two tables based on the columns of data that we have 
selected.  Clicking on the line connecting the tables will highlight the 
columns of data creating the link.

Links are allowed on a “one to one” and “many to one” basis presently in Power Pivot.

Another way to create relationships in Power Pivot is through the ‘Design’ option on the ‘Relationships’ group tab of the Power Pivot window:

Select ‘Create Relationships’.  The following dialog box will appear:

Design option

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

We want to connect the ‘DimProductCategory’ and the ‘DimProductSubCategory’ tables together using the common column ‘ProductCategoryKey’:

	 •	 Under the ‘Table’ drop-down box, select the table ‘DimProductCategory’
	 •	 Under the ‘Column’ drop-down box, select the column ‘ProductCategoryKey’
	 •	 Under the ‘Related Lookup Table’ drop-down box, select the table ‘DimProductSubCategory’
	 •	 Under the ‘Related Lookup Column’ drop-down box, select the table ‘ProductCategoryKey’
	 •	 Select ‘Create’ to link these tables together.

We can now go through the rest of the dataset and create relationships between the tables.  Have fun practising!  

We’ll continue next month.  Stay tuned for our next post on Power Pivot.  In the meantime, please remember we have training in Power Pivot which 
you can find out more about at www.sumproduct.com/courses/power-pivot-power-query-and-power-bi.

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we look at 
the equivalent of Excel’s LEN function.

Previously, we have looked at how to replicate some commonly used 
Excel functions.  Readers will recall that it does not always work in the 
same way as Excel.  The M code behind Power Query uses different 
functions, which can be annoying when you are used to using familiar 
Excel functions.  This month, we are going to look at another useful Excel 
function, namely LEN():

LEN(text) returns the number of characters in a text string. 

To demonstrate, let’s have some example where we must determine how 
many characters there are in the Expense Type column below:

Let’s use the Excel function first to show that the Power Query calculation will return the same value.

Power Query Pointers
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Now we have this calculated column, let’s try this again in Power Query.  In the ‘POWER QUERY’ tab, select the ‘From Table/Range’ option in the 
‘Excel’ section and load the data into the Power Query Editor:

The next step is to find a text function that will do a similar job to LEN().  In the Power Query formula pages, we can find the following:

The very first function appears to do exactly what I want –
Text.Length: Returns the number of characters in a text value
In the ‘Add Column’ tab, choose to create a ‘Custom Column’:
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Now when we click ‘OK’, we can compare the two columns:

The calculations match.  This means that when we need to include a text length on a large data set, we can find it in Power Query which is quicker and 
more convenient if we plan to use it in further calculations in Power Query, or simply on large amounts of data. 

More next month!

The update onslaught continues unabated.  Microsoft continues to be highly active in adding new features and improvements to Power BI Desktop.  
The full list of updates for June are as follows:

Latest Updates for Power BI Desktop

	 •	Visual level filters for slicers 
	 •	 Sorting for the ‘Performance Analyzer’ pane 
	 •	 Conditional formatting updates for formatting options
	 	 	 o	 Visual background and title colours
	 	 	 o	 Card colours 
	 	 	 o	 Gauge fill 
	 •	Visual header tooltips 
	 •	 Table and matrix total label customisation 

	 •	 Key influencers visual updates (Preview)
	 	 	 o	 Key Influencers with Live Connect to Power BI datasets 
	 	 	 o	 Key Influencers accessibility 
	 	 	 o	 Support for Cloud RLS
	 •	Manage aggregations dialog accessibility (Preview)

	 •	 New DAX comparison operator: ==

	 •	 Personalised Visualization pane (Preview)

	 •	Connect to shared and certified datasets (Preview)
	 •	Common Data Service connector is now Generally Available
	 •	 Enhancements to the Cosmos DB connector

	 •	 Updated pane design.

Let’s go through each new feature in turn.

Reporting

Analytics

Modelling

Visualisation

Data Connectivity

Other
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This update allows you to finally add a visual level filter to slicers.  It works just like any other visual level filter.  It will just filter the slicer itself and no 
other visuals.  This can be useful for filtering out blanks or if you want to use measure filters. 

There is a small update for the new ‘Performance Analyzer’ pane.  You can now change the sort direct and pick to sort between:

	 •	 Total time spent
	 •	Order the actions occurred 
	 •	 Time spent for the DAX query
	 •	 Time spent querying the source (for Direct Query)
	 •	 Time spent displaying the visual.

Power BI Desktop is extending its conditional formatting option to formatting features this month.  First, support has been added for conditionally 
formatting the visual’s background and both the visual title’s font colour and background colour.  

The filter that the slicer applies to other visuals doesn’t change – it's still just the selection made of the value in the slicer.  In the example above, 
Power BI doesn’t also wrap the ‘Avg. Sales > 1000’ filter into the filter applied to other visuals.

Visual level filters for slicers 

Sorting for the ‘Performance Analyzer’ pane

Conditional formatting updates for formatting options

VISUAL BACKGROUND AND TITLE COLOURS
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Secondly, for the card visual, you can now also conditionally format the data label and category label colours.

Lastly, you can conditionally format the fill color of the gauge.  With all these updates, you now have greater flexibility when formatting your visuals.  
In addition, there are plans in the pipeline to add more expression-bound formatting options in the coming updates as well. 

CARD COLOURS

GAUGE FILL

Microsoft has noticed that users frequently add helpful information 
for their end users to reports, such as hints on how to interact with the 
report or descriptions of the fields used in the visual.  Setting that up 
does take a fair amount of work, so they have now added a way to add a 
ToolTip directly to the visual’s header. 

This option is switched off by default, but you can turn it on through 
the ‘Visual header tooltip icon’ toggle in the ‘Visual header’ card of 
the Formatting pane.  This is the one toggle within the card that affects 
whether the icon shows in edit mode, as well as reading mode. 

Visual header tooltips 

Once the toggle is on, you’ll see a question mark icon in the visual’s header,         , and you’ll see a new Formatting card in the pane called ‘Visual header 
tooltip’.  In this card, you can add the text to show in the ToolTip and the formatting of the ToolTip.  Alternatively, you may pick a Report page ToolTip 
instead if you need more customisation.
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Once you’ve added ToolTip text or selected a Report page ToolTip, you’ll see it on hover over the question mark icon.

Many users have asked for the option to allow the total label for table and matrix to be customised.  Microsoft has duly obliged.  Now, you have the 
option to change the label under the Subtotals card for both columns and rows. 

Table & matrix total label customisation 
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You can also customise the label for each subtotal field when stepped layout is off. 

There is now added support for the Key Influencers Preview visual when you are Live Connected to Power BI datasets in the Power BI Service.  When 
using a report that Live Connected to a Power BI dataset, the visual should now be enabled and work just like it does for imported models. 

There’s also added support for the accessibility feature.  You can now navigate the visual using just a keyboard, utilising a screen reader to read off 
the information from the visual, and turn on high contrast mode and see the visual updated appropriately. 

Some specific keyboard shortcuts include:

	 •	 CTRL + Right Arrow to move focus inside the visual
	 •	 ENTER / SPACE to select whichever bubble is in focus
	 •	 When a bubble is selected, focus moves to the drill visual, and ESC will close it.

Key influencers visual updates (Preview)

KEY INFLUENCERS WITH LIVE CONNECT TO POWER BI DATASETS 

KEY INFLUENCERS ACCESSIBILITY
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When viewing a report in different RLS roles, you can now use the key influencers visual and see the types of insights your consumers will get when 
viewing the report with the proper security applied.

SUPPORT FOR CLOUD RLS

The Manage Aggregations dialog, which is part of Microsoft’s aggregations Preview, is now accessible.  You can use a keyboard to navigate around the 
dialog along with a screen reader to read off information about what’s in focus.  High contrast modes are also supported.

There’s a useful DAX update with the addition of a new comparison operator, ==.  This operator is similar to the existing = operator, except that it 
performs strict comparison to BLANK values (rather than treat zeroes similarly).  Think of it as an “if an only if is equal to” operator.

With this month’s update, Microsoft has tweaked the Visualization section of the pane to allow for personalisation.   With the personalised Visualization 
pane Preview turned on, you can now pin any marketplace visual to your pane and have it show up automatically for you every time you open any report.  

Any marketplace visuals you add to your report now show up below a dashed line.:

As you work to build a data culture where organisations leverage insights every day at all levels, a key part of that is ensuring availability of standard, 
authoritative datasets that represent a single source of truth.  This allows users to make decisions on trusted data and provides visibility and control of 
governance.  To enable this with Power BI, Microsoft is previewing shared and certified datasets. 

If you plan on using any of these visuals across multiple reports, you can right-click on the visual to pin it to the pane:

Once a visual has been pinned, it moves up to live with the other built-in 
visuals.  This visual is now also tied to your signed in account, so any new 
reports you built will automatically have this visual included, assuming you 

are signed in.  This makes it very easy to standardise on a particular visual 
from the marketplace without needing to add it to every single report.  
That used to be very frustrating!

Manage aggregations dialog accessibility (Preview)

New DAX comparison operator: ==

Personalised Visualization pane (Preview)

Connect to shared and certified datasets (Preview)
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With Shared Datasets in Power BI, you are allowing a single dataset to be 
used by multiple reports, even across workspaces.  You can either build 
new reports based on datasets in different workspaces or you can copy 
existing reports across workspaces.  With Certified Datasets, organisations 
now have a mechanism to distinguish the most valued and trusted 
datasets.  Certified datasets show up prominently so users can easily find 
these authoritative data sources.

In Power BI Desktop specifically, you can connect to shared and certified 
datasets directly.  Microsoft has provided the option with this update 
that when you connect to Power BI datasets you can now sort on name, 
endorsement, owner, workspace or last refresh time.  You can also search 
in the dialog too. 

That’s right – not much more to say.

Ditto, kiddo.

Microsoft has refreshed much of the pane interface.  They have updated all of the panes, the footer, and view switcher to be a lighter color, updated 
spacing, and created new icons.  Microsoft states that their new look is “much more modern and is the first step and refreshing the entire interface”.  
We’ll wait and see.

That’s it until the August newsletter.

Common Data Service connector is now Generally Available

Enhancements to the Cosmos DB connector

Updated pane design

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

This latest release has many reporting features, including conditional formatting for titles and other visual objects, the ‘Performance Analyzer’ pane 
and accessibility support for visuals.  The new Modeling (sic) view is also featured in this release.  

Here’s the complete list:

Latest Power BI Report Server updates

	 •	 Cross-highlight on a single point in line charts
	 •	Word wrap on titles
	 •	Update default visual interaction to cross-filter
	 •	 Rounded corners for visual borders
	 •	 Single select slicer
	 •	 Heat map support for Bing maps
	 •	 Cross-highlight by axis labels
	 •	Default ToolTip formatting
	 •	 Static web URL support for buttons, shapes and images
	 •	 Page alignment options
	 •	 Selection pane improvements
	 •	 Formatting updates for maps
			   o	 Adjust map points to a smaller size
	 	 	 o	 Ability to add zoom buttons
	 •	Accessible visual interaction
	 •	Conditional formatting for visual titles 
	 •	 Conditional formatting for web URL actions for buttons, shapes and images
	 •	 ‘Performance Analyzer’ pane
	 •	 Table and matrix keyboard navigation
	 •	 Line data label position control
	 •	 KPI visual Indicator text size control

	 •	 Show dates as a hierarchy now Generally Available

	 •	 New Modeling view Generally Available
	 •	New DAX functions
	 •	Update to the ALLSELECTED DAX function
	 •	Disable auto-date tables for new reports.

Let’s go through them.

You can now cross-highlight on a single point in a line chart to filter not only on the category but also the individual date.  When you click on the point, 
that individual point will show a marker indicating which point is the source of highlighting.  If your visual is very dense, it will select the closest point 
to your click to use as the source.

With this change, the line chart now behaves exactly the same as a stacked column chart in terms of interactivity.  You can continue to use the legend 
when you filter just on the categorical value.

Reporting

Analytics

Modelling

Cross-highlight on a single point in line charts
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There’s a new formatting option for visual titles this release: word wrap.  For example, if you have titles that are currently being truncated,

If you want to change all of your visuals to cross-filter each other quickly instead of cross-highlight, you no longer need to manually change all your 
visuals one by one using the ‘Edit visual interactions’ feature.  Now, all you need to do is go to the Options dialog and check the new option under the 
current file report settings, namely ‘Change default visual interaction from cross highlighting to cross-filtering’:

you can now turn on the word wrap option in the Title card

and your title will now show on two or more lines:

This doesn’t change the labels on the y-axis: widen the chart to make text clearer in this instance.

Word wrap on titles

Update default visual interaction to cross-filter

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

This will make the visual interaction cross-filter by default.  You can still manually update visuals if you just require a few to be cross-highlighted 
instead.  This will also not change any visual interactions you have already set manually.

This sounds ridiculous, but this is one of Liam’s favourites.  Another new formatting option is the ability to round the corners of your borders.  That’s 
right – little things please little minds!

To use this option, go to the Border card in the Formatting pane, and adjust the radius from zero (0) to the desired roundedness (we appreciate this 
is not exactly obvious!).

Rounded corners for visual borders
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The single select slicer option has been revamped to support radio buttons and allows one and only one filter selection.  Additionally, for drop-down 
slicers, it closes the drop-down after selection, making the interaction much quicker for end users.

You can now enable a heat map formatting option for the circle Bing map visual.  You’ll see an option to convert all of the location dots on your map 
to a heat map layer through the Formatting pane.

You can still use the previous behaviour, whereby clicking a selection replaces the filter but users may now CTRL + Click to multi-select, by turning on 
the ‘Multi-select with CTRL’ option instead.

Single select slicer

Heat map support for Bing maps
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Once that option is turned on, the map will automatically replace all the dots with the heat map layer:

If you don’t have anything in the ‘Size field well’ bucket, the gradient is based on location density (how many dots are in that area).  If you also have 
a measure in the Size bucket, the results are weighted by the measure’s value as well.

When you open the heat map formatting card, you’ll also see a lot of formatting controls.  You can set the radius and units for the radius to adjust the 
layer in addition to the colours used and their transparency.

You can now use the axis category labels to cross-highlight, just like the data points in the visual.  This is very useful when a category might be very 
small and hard to click.

While using the heat map layer, you won’t be able to select individual points or see any ToolTips.

Cross-highlight by axis labels
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Another use is if a category is broken out by another series in the legend.  This lets you select all values with just one click.

When you cross-highlight through the axis labels, the axis label is emboldened.

You can now format the default ToolTip for each visual in your report.  You can modify the ToolTip colours, fonts and transparency, which you can find 
in the ToolTip card of the Formatting pane.

To easily set these options across your whole report, you can control them as part of your theme.  Here’s an example of the JSON for the ToolTip 
section specifically:

Default ToolTip formatting
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You can now link a specific website through an image, shape or button.  You can do this by selecting the ‘Web URL’ option in the Type dropdown of 
the Action card of the Formatting pane.

You can now choose to align your report pages to the top the view instead of the centre through the ‘Global Report’ settings.

The ‘Align the canvas to the top of the wallpaper’ option is the default for new reports where users are using new filtering experiences.

Changing the setting will only apply to new reports going forward.

This will automatically take you to the URL when you click on the button (CTRL + Click in Edit mode).  In the Power BI Service, a new tab will be opened 
for the site.  This URL will need to be a valid URL starting with either http:// or https://.

Static web URL support for buttons, shapes and images

Page alignment options
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You can now double click an object in the Selection pane to rename the title.  If the title is switched off currently, you can still rename it through the 
Selection pane to make it easier to identify different objects in the list.

You can also use SHIFT + Click, along with CTRL + Click, to quickly and easily select many objects in the Selection pane at once, and adjust their 
visibility all together using the ‘Show and Hide’ options at the top of the pane.

Selection pane improvements

If the default bubble size is too large for your tastes on the bubble Bing maps, you can now adjust the bubbles to a smaller size.  Just slide the Size 
control under the Bubbles card to the left to reduce the size.

You now can add zoom buttons to your map.  Zoom buttons can make it easier to zoom in and out of the map, especially if you don’t have a mouse 
with a scroll wheel on it.  You can turn them on through the ‘Zoom buttons’ toggle under the ‘Map controls’ card.

Formatting updates for maps

ADJUST MAP POINTS TO A SMALLER SIZE

ABILITY TO ADD ZOOM BUTTONS
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You can now access data points on many of the built-in visuals using keyboard navigation.  When a visual is in focus, pressing CTRL + Right Arrow will 
move focus inside the visual.  Focus will now cycle between the plot area, categorical axis, and legend (if it exists) using the TAB key.  Press ENTER to 
select either the plot area or the legend and from there you can use:

	 •	 TAB or Arrow Keys to navigate between data points or legend items
	 •	 ENTER or SPACE to select and cross-highlight that data point
	 •	 CTRL + ENTER or CTRL + SPACE to cross-highlight multiple data points
	 •	 CTRL + SHIFT + C to clear all of the selection
	 •	 SHIFT + F10 or the designated key on your keyboard to open the context menu to access options like Insights and Copy.

Since the initial release of Power BI, end users have been able to customise the titles of their visuals, but they have always been static text (e.g. they 
will not change formulaically or via the use of conditional formatting).

Since Power BI reports are interactive, it makes sense that you may want 
your titles to be dynamic and reflect the current state of the report.  You 
can now use the conditional formatting dialog to change the text of your 
report based on a DAX expression in your model.

First, you’ll need to create a field in your model to use for your title.  For 
example, here’s an expression that will change based on the filter context 
the visual receives for the product Brand name.  One thing to note is that 
this field needs to be formatted as text:

Then, launch the conditional formatting dialog by right-clicking the ‘Title text’ area in the Property pane card and picking ‘Conditional formatting’.

Accessible visual interaction

Conditional formatting for visual titles 
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After that, in the dialog, select a text field from your model.  This can be a column or a measure.

Now the visual’s title will respond to changes in the report.

Once such a title is set, you can re-launch the dialog by clicking the fx button in the Property pane or revert to the default using the context menu.

You can also use the same expression-bound formatting to make the URLs of your buttons dynamic.  It’s set up in exactly the same way as titles.  This 
can be very useful if you want users to navigate to other webpages with URL parameters based on their current selection.

When a report is running slowly, it can be difficult to know what you can do to optimise performance.  To help with this, Microsoft has introduced a 
new ‘Performance Analyzer’ pane in Power BI Desktop.  As an analyst, you can use this pane to see where the time is being spent.
You can open this pane through the View tab in the Ribbon.

In future releases, Microsoft will be rolling these conditional formatting options out to more properties on more visuals and give end users more 
ways to set the expression.  The goal is that you will be able to use rules, a measure or enter an expression directly in the dialog and use the result 
to format any property.

Conditional formatting for web URL actions for buttons, shapes and images 

‘Performance Analyzer’ pane
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When you first open the pane, you’ll see an empty pane, and all you need to do is select ‘Start Recording’ to see what queries are being run.

Once you start recording, any action that runs a query, such as changing a page, refreshing the visuals, or cross-highlighting, will populate the pane 
with information.  You’ll see each visual logged in load order with its corresponding load duration.

You can expand a specific visual’s log to see how the time was spent divided out in three different sections:

	 •	 DAX query: the length of time it took for Analysis Services to run the query
	 •	 Visual display: how long it took for the visual to draw on the screen (including anything like retrieving web images or geocoding)
	 •	 Other: covers time that the visual spent preparing queries, waiting for other visuals to complete, or doing some other background processing.

You’ll also see data for how long your DirectQuery source took to return a result if you’re in that mode.
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You can also export all the query information to a JSON file to analyse in other tools.

If you want to dig into one slow loading visual specifically, while the Performance Analyzer is running, there will be an icon in the visual header that 
will let you refresh just that specific visual to see the statistics in the pane.

The Performance Analyzer is currently available in Power BI Desktop only and doesn’t show all the time spent for the R or Python visuals.

Microsoft has added support for interacting with most visuals for keyboard and screen readers, and that support is extended to the table and matrix 
visual.  Now when your focus is on a table or matrix, you can use the CTRL + Right Arrow Key to move focus inside to the first cell of the visual.

While your focus is on a cell, the screen reader will read off the relevant information, and you can use the follow keyboard shortcuts to navigate:

	 •	 Arrow Keys: move your focus up/down/left/right on cell
	 •	 SPACE or ENTER: select cell
	 •	 SHIFT + Right Arrow Key: expand an expandable header
	 •	 SHIFT + Left Arrow Key: collapse an expandable header
	 •	 CONTEXT Key or SHIFT + F10: open context menu.

Table and matrix keyboard navigation

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

When you have a line or combination chart with multiple lines 
overlapping with each other, it can sometimes be hard to tell which 
data label corresponds to which line.  To help with this, Microsoft has 
added a new position control for data labels so you can set the labels to 
specifically show above or below its corresponding line.  

Take for example, the below line chart showing the average net 
satisfaction and likelihood to purchase again.  Many of the data labels for 
the first several months are showing near each other with the automatic 
layout.

To help differentiate between the two, you can now customise the position so the labels for the PurchAgain line show below it and the labels for the 
NSAT show above it.

Once you do that, it’s a lot clearer which label goes with which line.

Line data label position control
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As a small formatting improvement this release, this update sees the KPI visual to support changing the text size of the Indicator.  It’s been a big pain 
point for some people, so it is good to see this issue rectified.

For each date column, Power BI now shows each hierarchy level in the Field list.  The entire hierarchy, or a specific selection from the hierarchy, can 
be used in visuals.

KPI visual Indicator text size control

Show dates as a hierarchy now Generally Available
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The new Modeling view is now Generally Available.  Some of the highlights of this new view include:

	 •	 Bulk editing of columns, measures, and tables
	 •	 Setting display folders on columns, measures, and hierarchies
	 •	Dragging and dropping into display folders
	 •	Multiple diagram layouts.

This update sees another new DAX function, ALLCROSSFILTERED.  This 
function may be used to remove filters on a table from other tables 
across direct or indirect many-to-many relationships.

You can now use either CONTAINSSTRING or CONTAINSSTRINGEXACT to 
get a Boolean value returned letting you know if a text field contains a 
specific string.  CONTAINSSTRINGEXACT is case sensitive.  Another new 
function is DISTINCTCOUNTNOBLANK to return a SQL like distinct count 
where blank values aren’t counted.

This update has also extended the LOOKUPVALUE function to now take 
an optional last parameter to avoid raising an error.  Lastly, Microsoft has 
also extended the ALL function so that using the ALL function without 
arguments will clear all filters in the Filter context.

Intellisense support is also supported for all these functions except the 
ALL updates and the new DISTINCTCOUNTNOBLANK, both of which will 
come in a later release (Microsoft states that this will be “April” but we 
think they are confused about that!).  Watch this space.

Further to the above, the ALLSELECTED DAX function has been extended to support multiple arguments, just like the ALL function.

If you don’t want to use Power BI’s auto-generated date tables, and instead, for all your reports want to use your own date tables, you can now turn 
off the feature in the Options dialog under Global -> Data Load -> Time intelligence.  Checking this box means that for any new files, Power BI will not 
automatically create any hidden date tables.

More anon.

New Modeling view Generally Available

New DAX functions

Update to the ALLSELECTED DAX function

Disable auto-date tables for new reports.

As we start the second half of 2019,  the Power BI team continue to keep this newsletter at maximum length as they add more and more features and 
updates to Power BI Service and Mobile.   Here’s the latest instalment of additions:

	 •	 Report commenting
	 •	 Custom navigation for Power BI Apps
	 •	 Governing Power BI visuals within organisations
	 •	 Enhanced e-mail attachment support for paginated reports
	 •	 May update for on-premises data gateway
	 •	 Updates to the Power BI mobile apps
	 •	 Roadmap updates.

Let’s go through them.

Power BI Service and Mobile Latest Update
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Commenting has now been added to Power BI reports.  With report 
commenting, you can directly add comments to report pages or specific 
visuals without switching context.  Power BI will also automatically 
capture your report view, so others reading the comment can view the 

report exactly as you did when writing the comment.  In addition, you 
can also @mention other individuals within your organisation to grab 
their attention.  The @mentioned users will receive an email and a push 
notification on their Power BI mobile application. 

Reporting teams now have the ability to customise navigation for end 
users, so they can find content quickly and understand the relationships 
between different reports and dashboards.  In addition, this update has 

also added the ability for app owners to configure the app name, set a 
theme colour, choose a new icon, and even adding a support URL to a 
new or existing app.  

This update provides in-depth guidance on how administrators may govern custom visuals within their organisation.  This is essential if you are an 
administrator in Power BI.

Report commenting

Custom navigation for Power BI Apps

Governing Power BI visuals within organisations
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The e-mail subscriptions feature has been enhanced for paginated reports in Power BI.  In addition to PDF, you can now choose the following new 
attachment types: PPTX, XLSX, DOCX, CSV or XML to be part of your subscription(s).  Further, Microsoft has also raised the attachment file size limit 
to 25 MB for paginated reports for large data exports.

An updated version of Power BI On-premises data gateway has been released. The latest version (3000.5.185) includes a preview of Gateway 
Performance Monitoring, Amazon Redshift Refresh and an updated mashup engine.  To try it out, simply install the new gateway.  You can find it here 

Microsoft is becoming more transparent advising users what’s coming in the next three to six months.  The latest teasers have been divulged.  Expect 
to see the following before the end of the year:

	 •	 Report performance metrics
	 •	 Managed distributions
	 •	 New refresh scenarios
	 •	 Insights: key influencers.

More soon we expect!

There are also a couple of updates for the mobile apps in various platforms:

	 •	 Key Influencers visual: support has been added for the key influencers visual on mobile so you can perform analysis of key drivers over your 	
		  data with just a few taps

	 •	 Maximise the view with full screen mode (Android and iOS): a new button has been added to let you control when to focus on your data by 	
		  removing report headers and footers and giving you maximum space for viewing your reports.

Enhanced e-mail attachment support for paginated reports

May update for on-premises data gateway

Roadmap updates

Updates to the Power BI mobile apps

Depreciation is a method of allocating costs over the useful 
economic life of an asset (e.g. a building, a car, a computer).  
This function returns the depreciation of an asset for a specified 
period using what is known as the fixed-declining balance 
method (explained to the right).  

The A to Z of Excel Functions: DDB
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The DDB function employs the following syntax to operate:

DDB(cost, salvage, life, period, [factor])

The DDB function has the following arguments:

	 •	 cost: this is required and represents the initial cost of the asset
	 •	 salvage: this is also required.  This is the value at the end of the depreciation (sometimes called the salvage value of the asset).  This value can 	
		  be zero
	 •	 life: this is required.  This is the number of periods over which the asset is being depreciated (sometimes called the useful life of the asset)
	 •	 period: another variable required.  This is the period for which you want to calculate the depreciation.  The period must use the same units as life
	 •	 factor: this argument is optional.  This is the rate at which the balance declines.  If factor is omitted, it is assumed to be two (2) (the double-	
		  declining balance method)
	 •	 Important: All five arguments must be positive numbers.

It should be further noted that: 

	 •	 the double-declining balance method computes depreciation at an accelerated rate.  Depreciation is highest in the first period and decreases 	
		  in successive periods.  DDB uses the following formula to calculate depreciation for a period:
		  Min((cost - total depreciation from prior periods) * (factor / life), (cost - salvage - total depreciation from prior periods))
	 •	 Change factor if you do not want to use the double-declining balance method
	 •	 Use the VDB function if you want to switch to the straight-line depreciation method when depreciation is greater than the declining balance 	
		  calculation.

Please see our example below: 

More Excel Functions next month…

Declining balance is a form of accelerated depreciation that will 
depreciate more aggressively than the straight-line method (where the 
same charge is applied in each period of equal length).  This method is 
appropriate when an asset has higher functionality in the early years 
of use and becomes obsolete quickly.  This method ensures that more 
depreciation is accounted for in the first few years, as a constant rate is 

applied to the remaining non-depreciated balance.  Fixed assets such as 
computer equipment are a good example since they are typically only 
used for a couple of years and then replaced.
This function returns the depreciation of an asset for a specified period using 
the double-declining balance method or some other method you specify.

Upcoming SumProduct Training Courses

Location Course Date Duration

Sydney Excel Tips and Tricks 15 Jul 2019 1 Day

Sydney Financial Modelling 16 - 17 Jul 2019 2 Days

Sydney Power Pivot, Power Query and Power BI 22 - 24 Jul 2019 3 Days

Sydney Excel Tips and Tricks 19 Aug 2019 1 Day

Melbourne Financial Modelling 20 - 21 Aug 2019 2 Days
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

There are over 540 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file a
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month, we thought we look at 
adding and subtracting:

Keystroke What it does

CTRL + Add (+) Open ‘Insert Dialog’ dialog

Subtract (-) Extend Selection mode

SHIFT + Subtract (-) Add to Selection mode

CTRL + Subtract (-) Delete cells
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Sydney Financial Modelling 20 - 21 Aug 2019 2 Days

Melbourne Power Pivot, Power Query and Power BI 26 - 28 Aug 2019 3 Days

Sydney Power Pivot, Power Query and Power BI 26 - 28 Aug 2019 3 Days

Melbourne Excel Tips and Tricks 17 Sep 2019 1 Day

Sydney Excel Tips and Tricks 23 Sep 2019 1 Day

Sydney Financial Modelling 24 - 25 Sep 2019 2 Days

Sydney Power Pivot, Power Query and Power BI 7 - 9 Oct 2019 3 Days

Melbourne Financial Modelling 14 - 15 Oct 2019 2 Days

Melbourne Power Pivot, Power Query and Power BI 22 - 24 Oct 2019 3 Days
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